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Submissions uploaded to BIDS are secure Many email filters automatically block messages that look suspect. I you are requested to provide a Clarification,
from public access. All data is considered Please make sure your email system and inbox is setup to accept emails thme I;a?e‘;and / ((erdl':tu” Prlo‘p?sal, ptl_ease
source selection sensitive and protected from administrator@tswg.net as this is the email account BIDS uses 7%§C\L,|vmgr{tlat?onr¥'i: rethdgg?edmino{fr?ea on
accordlingly. Submissions are reviewed by to notify you of the results of your submission. Regardless, it is always hotification email. Failing to provide this

the user and authorized evaluators only. advisable to login and check your dashboard every two weeks for updates. information will slow the approval process.

Getting Started

Homepage View or Download a BAA

The Homepage offers several areas of interest to submitters. Check the From the Homepage: I
BIDS Advisory and Announcements section for information about BAAs o Click Download BAAs

and other news items. i i e NN ‘
* Right click to save file locally. e e e oy

W : ® Select Save Target As.
A A .y _(1

Wnload BARS & SubmItter QUicKCard ® CTT1SO Portal & M RGS Feed

Lo g BIDS Advisory and Announcements i |
New to CTT50 BIDS? E | - :
e S Do Login is not required to download a BAA or access help.

e Name the file and click Save.

Register here
The BAA 12-Q-4701 is no longer accepting quad chart proposals. Please check back
or subscribe to our RSS news feed for information on current or new BAAs

Use the RSS (Really Simple Syndication) news feed to Accounts and Password Information
automatically receive BIDS notices. See Online Help for

set up instructions. Account integrity is critical to BIDS and the soliciation process.
E-mail is the only method of communication between the
Government Contracting Officer and submitters. Be sure to

) maintain the correct information in your BIDS registration.
General BIDS Help U .

Help links are available to all users in any BIDS view. Contact the Help Desk for point of contact (POC) changes during an

« Online Help - provides instruction on topics related to BIDS use. active BAA. Be prepared to verify company identity, account information,
) ] and the reason for the change.
® FAQs - lists frequently asked questions and answers about BAAs.

* BAA Questions - provides answers to submitter questions about
ific BAAs and i ts. i i
SPECIIC BAAS and requirements New Accounts and Reregistering
The BIDS registration POC should reflect the submitter’s contract
authority.

Web Browser Settings e Register if you are a new user to BIDS and a submitter account
does NOT exist.

* Help Request - submits an e-mail to the BIDS Help Desk.

BIDS to work properly. In addition, disable any third party e Reregister if a POC is no longer valid and no submission

Browser settings must be configured to allow pop-ups for
A evaluations are pending.

pop-up blockers.
Do not reregister if a valid account exists and submissions are
pending evaluation.
Doing Business with the Government

This section provides links to other Government sites that will help P d
submitters prepare for contract award. asswords

| Doing Business with the Government A Protect user names and passwords at all times.

GETREADY T0 DD Wendors that contract with the Federal .
. BUSINESS Gt el v e vl * Change the account password especially when changes to
WITH THE

prerequisites before a contract is personnel OcCcur.
awarded,

e Passwords should be at least six digits. Include alphanumeric
combinations of upper and lower case letters and special characters.

Help with Submissions

Be sure to follow the guidance provided in the BAA when creatin
submissions. ¢ P g Forgot My Password

Registered users with a valid e-mail address can automatically reset a
Examples and templates are available online. password.

From the Homepage:

From the BIDS Homepage: e Select Forgot My Password.

¢ Under Downloads, click Reference Materials. « Enter required information

¢ Under Document Format, right click the document of choice. e Click Submit.

e Save the file locally.
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Registration and Other User Information

Submitting a Registration
A registration is required to respond to a BAA.
From the Homepage:

New to CTTSOD BIDS?
Reqister here

—
COGIN
Have an idea or product in response to a BAA Invited to participate as a source selection team
requirsment? m

¢ |n the Login panel, click Register here.
e Select Submitter as the registration type.

ICTTSO BIDS Registration Pr;(ss
® Next click Continue
DRt e ! )
Evlsator -k Hore to Registration.
e et o o] Ao Complete all
(ol s o A, ad e .
mandatory fields
(marked *) on the
registration form.

[Already have a registration?

1f you know your usemarne, but not your password, change yot

1f you donit , create 1

% User Names must be unique to the database and contain no
{/ special characters or spaces.

e BIDS registration business information is used for statistical data
collection only. To ensure accurate analysis and consideration in
special business programs, current information is requested.

F

“Business Type' [T gy Program Participant

(Check all that apph CIHUB Zone Firm
DHisturicaIIy Black Collegeilniversity
[ Minarity Institution
CMinority Gwned | Minatity Type v
[Large Business
[ Small Business| 51- 100 v [2.000.001- 35 Million  +|
[ small Disadvantaged Business
[weteran tnwned Business [ Semice Disabled
“liwaman owned Business
[ Educational Institution
I ronprofit Institution
CIResearch Ingtitution

Ol Gaovernment | Government Type v

O other|

THUsiness Location: | g only ~l|| Select Foreign Country

*Congressional

District: |V|RG|NIA
(Btate and District

NUmben gooreh by zip code at wwi house o ovwelcome himl

v”ﬂ v

Subrmit

e Click Submit; make sure the Success Message displays.

Submitter registration is automatic and will be acknowledged by
e-mail. Be patient this takes several seconds to be recognized

'New to CTTSO BIDS?
|Register here

From the Homepage:
e Enter your User Name.
e Enter your Password.
e Click Login.

Updating Contact Information
e From My Account, select Edit My Account.
¢ \erify and edit contact information as required.

e Click Submit.
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Change Password
e Under My Account, select Change My Password.
¢ |n the Old Password field, enter your current password.
¢ In the New Password field, enter a new password.
¢ |n the Confirm Password field, re-enter the new password.
e Click Submit; ensure the Success Message displays.

Changing the password will terminate the BIDS session and you will
need to login using the new password.

Evaluation Criteria and Other BAA Information

Evaluation Criteria

Submissions are evaluated according to individual merit and
relevance to the program requirement rather than against other
proposals. Evaluation criteria highlights from the BAA package are:

Basic Requirement:
® Proposed solution meets the stated requirement.

® Proposal exhibits comprehensive understanding of the problem
and the requirements of intended users.

e Multiple users (U.S. Government or commercial).

Cost:
e Achievable, reasonable, and complete for work proposed.
e Costs analyzed and risks addressed.

Schedule:
e Achievable and reasonable for proposed solution.
e Risk and critical elements addressed.

Technical Performance:
e Approach is feasible, achievable, and complete.
e Technical team has expertise and experience.
e Effort defined, complete, and in logical sequence.

¢ Deliverables and products clearly defined and will meet the
requirement.

e Technical risks and mitigation defined, feasible, and reasonable.

e Government Furnished Equipment and materials are identified
with need dates.

e Intellectual property ownership addressed.
e Transition to production addressed.
e Other agency interest or funding is documented.

Past Performance:
e Success in similar efforts.

e Demonstrated ability to deliver products within budget and
schedule.

e Team has demonstrated expertise in the technical area proposed,
and in cost, schedule, and risk management.

All submissions must follow the instructions in the published BAA
package. Include all specified information to avoid disqualification
or delays in evaluation. Always refer to the published BAA package
for the most up-to-date guidance.

Mandatory BAA Closing Date and Time

Every BAA will specify a closing date and time. Times are always in the
current Eastern Time zone. Submissions will not be accepted after closing.

Be sure to register, login, and upload submissions early.

For Assistance, Contact the BIDS Helpdesk: E-mail: bidshelp @cttso.gov




Submitting to a BAA Requirement

Uploading a Submission

Before you begin, review Tips and Hints for Success (see back page).
Know the location of the file to upload. Check the file name and file size.

e Login to BIDS.
e Under Submitter Dashboard, select Submit to a BAA.

Home e Submitter QuickCard e Proposals Due e CTT50 Portal © ™ RSS Feed

SUBMITTER TOOLS
Submit to 3 BAA
Past Submissions

Submitter Dashboard

Submissians Due Submissions Reference

Check My Current Proposals Review Templates or Other

Reference Materials

BAAS

Reference Materials SR SRR
Update Account Information
Edit My Account (E-mail)

Change My Password

e Under Open BAAs, click the BAA of interest.

e Click the requirement number of interest.

e Review the checklist, click OK to continue.

e Complete the required fields in the submission record.

iew Quad Chart for Q€D
BAA: 08-Q-TESTRO  Requirement: ABC Requirement ABC

*Note: Please review the BAA to be aware of any recent revisions.

Fields marked sk (*) are required.
o

:

enter a tracking number for the submittal. See FAQ section Submissi
Preparation for clarfication on completing this naming process.

® ves, unlimited rights

O No, other than unlimited rights
O es, human subjects will be used
® o, humans will not be used

nts (TEXT oMLY
The submissian ortains no lassifed data|

ll ®ves, unlimited rights
O No, other than unlimited rights

L O ves, human subjects will be used

Call SpeliCheck. o B ® 1o, humans will not be used

* Attachment: |

[ Eowe] . .
Ihere re no atactments on s ncumen. riese o] O€1€CT the appropriate radio button
to provide the response.

e Use Browse to select a file.

e Click Submit for Processing.

¢ \Wait for the Success Message to display.

e To verify proper file upload, click the file attachment link.

BIDS ission - Successful

Your proposal has been successfully submitted to the BIDS System. Click on the link below ta view your saved
submission:
CISTERN

that you click on the link(s} below ta test your uplaaded document(s):
CISTERNw2.p:

Note: If you need to reattach or replace a file, you must first remove the current file attachment,
then attach the new file.

Shot-gunning or uploading a submission to every requirement is
not good practice and is strongly discouraged.

Modifying a Submission
Make all edits or corrections to the document on the local computer.
e | ogin to BIDS, select Check My Current Proposals.
Select the document identifier to open the submission.
Click Edit Submission.
Use Browse to select the updated file.
Select the checkbox to remove the previous file.
e Click Submit for Processing.

Changes to uploaded responses will be permitted up to the closing
date and time. Changes after the due date are not permitted.
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Checking Submission Progress
e | ogin to BIDS, select Check My Current Proposals.

|Hnme ® Submitter QuickCard e Proposals Due @ CTTSO Portal « & RSS Feed

Past Submissions
Submission Type Status Date
TAW-IE8Reql-QED-Chrome Quad Chart  Pending Evalustion 18-NOY-2011
TAW-REQTAW1-QED-ThreeFourFP Full Proposal  Pending Evaluation 22-AUG-2011
TAW-REQTAW1-QED-OneTuwoWP hite Paper  Accepted 22-aUG-2011
TAW-REQTAW1-QED-QED-T2 Quad Chart  Pending Evalustion 18-AUG-2011
TAW-REQTAWI-QED-QED1 Quad Chart  Accepted 18-AUG-2011

e Open the submission you wish to view.
e Your most recent submission will be at the top of the list.

Removing a Submission from Consideration

Submissions can only be removed from consideration before the BAA
closing date or before the follow-on submission due date.

e | ogin to BIDS, select Check My Current Proposals.

e Select any submission with the status “Pending Evaluation.”
e Click Delete Submission.

e Click Submit for Processing.

Uploading a Follow-On Submission

For each follow-on phase, submitters are prompted at first login to
update/validate registration information.

e | ogin to BIDS, select Submit a Request Proposal.
e Click the appropriate submission to open the record.
e Click Create Next Submission.

e Review the checklist and click OK to continue.

e Complete the required fields.

e Use Browse to select the file.

e Click Submit for Processing.

No Bid Guidance

When a follow-on submission is not planned for upload by the submitter,
a notice in BIDS is required. Provide a letter (attachment) as the next
submission upload indicating the submission has been revoked from
further consideration.

Phase | Document Preparation

Quad Charts

Quad charts are a single page, divided into four quadrants and provide
the essence of the proposed solution for a specific requirement.

Use the sample Quad Chart as guidance. Refer to the BAA
package for all content requirements. Quad Charts do not
require a cover page.

From the Homepage:
e Under Downloads, select Reference Materials.
e Under Document Format, select either Quad Chart sample.

For Assistance, Contact the BIDS Helpdesk: E-mail: bidshelp @cttso.gov




Tips and Hints for Success

Document Identifier

Each submission must contain the document identifier for that
submission in the header.

The format is: XX-REQTNO-USERNAME-SIT#
e XX - Subgroup or Mission Area.
e REQTNO - Requirement Number.
e USERNAME - BIDS User Name / Submitter Login Name.
e SIT# - Submitter Internal Tracking Number.

The prefix (underlined in the format above) is based on the selected BAA
mission area, requirement, and submitter’s user name. The SIT number
will be entered by the submitter when the submission is uploaded. SIT
numbers must be unique and must contain only alphanumeric characters,
hypens, and underscores.

Suggested SIT Number Formats

Submission Type

Quad Charts
White Papers
Full Proposals

Suggested Naming Conventions

####-QC, ###-QC2, ... | QCO1, QCO2, ...
###H-WP ####-WP2, ... | WP0O1, WPO2, ...
HH#E-FP #H#-FP2, FPO1, FPO2, ...

File Naming

File attachment names should consist of alphanumeric characters,
hyphens, and underscores only; special characters are not allowed.
Correct file names before beginning the upload process.

P
s Apple/ Maclntosh users must have the entire file name and path
free of special characters and spaces.

Merely editing the file name in the Attachment field on the
submission form will result in a submission record with no file
attachment.

Public Access — Up-Loading Options

Up-Loading a submission from computers such as those found in public
libraries or businesses is permissible. Keep the following security
guidelines in mind:

e Store attachments on an external media (CD-ROM or Flash drive).

® Do not save any information on the local computer.

e Keep all login information private.

® Do not let the computer “remember” the login name and password.
e \When finished be sure to clear the browser history and cache.

Clearing the Computer Cache
Internet Explorer
e From the Tools menu, select Internet Options.

e Under General, Temporary Internet Files, select Delete Cookies,
click OK to perform action. Select Delete Files, include Delete all
offline content. Click OK to perform action.

e Under General, History, select Clear History. Click OK to
perform action.

e Click OK to return.
Firefox 3.6 or higher
e From the Tools menu, select Clear Recent History.

e Set Time Range to Everything and select all check boxes, then click
the Clear Now button.

e From the Tools menu, select Options and click the Advanced tab.
e Under Offline Storage, click the Clear Now button.
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Restrictive Marking on Proposals

Clearly indicate content disclosure limitations on all submissions.
Markings can appear as “Proprietary” or words to that effect; however,
do not use “Company Confidential” or other phrases that could be
confused with national security classifications.

Procedures for Classified Submittals

First, the submitter must create a placeholder record in BIDS. Attach only
the cover page. Indicate in the Comments field that the document cannot
be uploaded to BIDS due to classification.

Next, the submission must be marked, packaged, and mailed in
accordance with handling requirements for the level of classification.
Include the BIDS document identifier in the header of the mailed
document. Refer to the BAA package for more information regarding
classified submittals.

Never enter or attach classified data in BIDS. Refer to the
published BAA package for classified data handling.

Classified documents MUST be received by the applicable due date and
time. Classification does not eliminate the requirement to comply with all
BAA instructions.

Format and File Size Limits

Document format is specified in the BAA package. The most common file
formats are Microsoft Word, Microsoft PowerPoint, Microsoft Excel, and
Adobe Acrobat (PDF). Any single uploaded file is limited to 1 MB (1048576
bytes). Help on reducing overall file size can be found in Online Help.

Tips to Reduce File Size
Adobe Acrobat
e From the File menu, select Reduce File Size.

e Select Acrobat Version Compatibility and click OK. Setting
compatibility to later versions of Acrobat will allow greater reduction
in file size.

e Select a location, enter a file name, then click Save.
Microsoft PowerPoint

e Select a graphic image in the file.

® Right click the image, select Format Picture.

¢ |n the flyout, select Compress.

e In the Compress Pictures frame, select All pictures in Document.
e Click OK.

; These instructions do not apply to Vista compatible applications.

Graphical Images
e Crop unnecessary borders or unused space.

e Resave the image as a JPEG, GIF, or other compressed format.

Remember, the resolution must be clear to print and view the final
document onscreen.

BIDS Email Notifications

The BIDS system is designed to send a notification email to

& submitters when a decision is made on their submissions. Recent
changes to email spam filters have caused a number of these
notifications to be deleted by the submitter's email system before
they reached their email box. Please remember that these emails
are a courtesy and that all submitters are required to check the
status of their submissions by intermittently logging into the
system and clicking the Check My Current Proposals on the
Submitter Dashboard.

For Assistance, Contact the BIDS Helpdesk: E-mail: bidshelp@cttso.gov




